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1 Scope of White Paper 

Benefits

There is a vast repository of data in Time Maters®, spread across muliple record types.  The main 

records (Contacts and Maters) contain over 155 customizable fields.  The ancillary records (notes, 

events, todos, and the five sets of user-defined records) each contain 55 customizable fields.  The 

custom record has an unlimited number of fields.  Even the teriary records (mail, phone, and outline) 
contain over a dozen fields.  And each of these fields, in turn can have a link to another record. 

Theoreically, a single mater or contact can have over 24,000 fields of data when couning data on 

records linked to the form.  When one then expands to data in related records, linked by automaic 

relaionships, the pool of data which can be gathered and managed in Time Maters and then pushed 

into automated document is mind boggling. 

Workflow is a term that covers an enire process from the entering of data into Time Maters forms, to 

the creaion of and finalizaion of client-facing documents.  Time Maters has a unique capacity to build 

data-rich, highly customized workflows.  The benefits for your firm are: 

• Improved efficiency in document creaion. 

• Improved workproduct from the use of standardized templates. 

• Improved accuracy from the muli-level validation of data used in the document creaion. 

• Improved speed from the use of an integrated document creaion system that eliminates the 

double entry of data. 

• Rich document and answer management. 

Methods

Time Maters does not just offer one work flow soluion .  It gives you a wide range of choices, each with 

their pros and cons.  In this white paper we will look at four different methods of using Time Maters to 

communicate with clients and create legal documents.  We will cover (1) Power Views, (2) Formatable 

Clipboards, (3) HotDocs® templates, and (4) merge templates. 

Power Views:  The shipping Power Views give you a taste of what is possible.  At Basha Systems, we 

have developed the 3-Click Soluion™: (1) choose the record, (2) choose the Power View, (3) print or 

display the result.  By developing dynamic Power Views that show all fields on the Contact, Mater or 

ancillary record, and grouping those fields by area into data islands on the Power View, we have turned 

Power Views into instant reports.  By then adding a separate CSS for prining the Power View, we now 

have instant data intake sheets that can be sent to clients to fill out and/or review. 

HotDocs Templates:  The integraion to HotDocs comes in several flavors.  In this white paper we will 

examine all opions.  The first and easiest opion to understand is the PULL method, which uses an 

answer source lookup to pull data from a selected record in Time Maters.  The second opion is the 

PUSH method, which uses a HotDocs Template Extension to define the template and map the fields to 

be pushed out into a HotDocs document.  The third opion is to use a combinaion of PUSH and PULL so 

as to get the maximum amount of data. There is a fourth opion to use a HotDocs data component and 

query the Time Maters SQL database directly. 
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Formattable Clipboards:  The power of clipboards in Time Matters is often overlooked.  Clipboards can 

contain several pages of text, data and rules.  They can be used across multiple records (like a merge), 

but unlike a merge pull in select related records. They can even include stop codes and prompts. We will 

look at several methods. The first option, and the one most often used, is the PULL, using the INSIDER 

button in a Word® document. The second option is to PUSH the clipboard out from a single record into a 

document profile record, and ultimately the document.  The third option is to push out multiple records.  

The fourth option is to combine these items into Action Triggers. 

Merge Templates:  When looking at merge templates you are looking at what most other programs call 

"document automation".  Start with a Word® or WordPerfect® document and add merge fields.  Time 

Matters supports basic merge templates, and even lets you bring in data from a primary data record and 

up to three linked and/or related records. 

Use for any document 

I have written extensively on the uses of document automation in the legal practice.  Here are some of 

the items where one of these four methods would reduce drafting time to minutes and seconds. 

Correspondence:  Clipboards and Merge Templates are ideal for personalized communications to clients 

via e-mail, mass mailings, and transmittal and other informational letters. 

Transactional Documents: HotDocs and Merge Templates are ideal for transactional documents, 

whether they be agreements, real estate documentation, estate planning forms, or banking and finance 

documents. 

Litigation Documents:  HotDocs is ideal for suites of templates driven by a single master interview.  Such 

systems can be applied to foreclosures, debt collection, credit protection and general litigation. 
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2  Power Views 

The Need 

Time Matters data entry forms are rich in detail.  

Data is spread across one or three fully 

customizable tabs, depending on the type of 

record.  But the question arises, how can you 

quickly get the data out of your record in a 

format that you can present to your client to 

review?   

Moreover, how can you quickly create a client 

intake form that is organized in the same way as 

your Time Matters data record?  If you could 

present your client such a form, they could fill it 

out before the client meeting and your paralegal 

or legal secretary could input it into Time 

Matters. 

The Solution 

Power Views are than just a "window" into your 

data records or your related records.  They can 

serve as documents.  Our 3-Click Solution™ for 

Time Matters includes a series of customizable 

Power Views that can efficiently display all data 

on a matter or contact record (or for that matter 

any record, including User-defined records).  

By using a "Label" property in a Time Matters Power View, we can dynamically display the labels in the 

record's underlying form style.  With the addition of a vb-script parser, we can correct those labels that 

describe two fields separated by a pipe so that they reflect the referenced field. 

 
 

Custom Power View created by Basha Systems. 

Finally, by using a 

separate printer CSS 

(Cascading Style Sheet) 

can create a Power View 

that can print out into a 

clean intake form. 

The printable form 

groups fields into islands 

which match the "areas" 

on the Time Matters 

data record, facilitating 

quick data-entry on the 

round trip back from the 

client. 

     Custom Power View created by Basha Systems. 

 

 

Custom Power View display created by Basha Systems.
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3  Formattable Clipboards 

Clipboards are the underutilized reporting engine of Time Matters. A clipboard can be as simple as an 

address block, or as complex as a multipage document with conditional text.  A clipboard can pull data 

off a single record and records "related" to that record.  Or a clipboard can be set to pull data from over 

a thousand records.  In addition, you can put in stop codes, formatting instructions (hence the name) 

and questions to the user.  You will also find the syntax used in clipboards can be ported over to Power 

View scripting and Time Matters report scripting. 

As powerful as Formattable Clipboards are, there are some limitations you should be aware of: 

• Formatting is very basic.  It does not include support for "styles," outline numbering or 

paragraph definitions.  Formatting is limited to fonts, font attributes, justification and color. 

 

• Conditional Logic is limited.  Formattable Clipboards include some scripting language to control 

optional text and fields.  The most powerful script feature is the SELECT / END SELECT pair.  

There is also IF / THEN / ELSE / END IF 

logic.  However, there is no support 

for nesting IF expressions, or 

combining SELECT and IF statements.  

If you want to apply more than a 

simple condition, you are better 

served moving onto HotDocs. 

If you are going to use a clipboard, and there are many reasons to do so, you have several methods of 

using clipboards. 

Pull Clipboards 

These are the most commonly used and best understood.  If you are running Word or WordPerfect 

there is an INSIDER button on the Time Matters toolbar.  To use the clipboard, here are some basic 

steps: 

• Click on INSIDER. 

• Choose the data source type (contact, matter, task, event or user defined record). 

• Use the quickfind feature to select the record or a search if required. 

• You may select a single record or tag multiple records. 

• Then choose the Clipboard.  If you double click, it will paste the clipboard into the document at 

the cursor point. 

Microsoft Word 2007.  Inside Office 2007, the clipboard will be found on the 

Add-Ins Ribbon.  At present, the icons are different, but the functionality is the 

same.  Just click on "Time Matters Clipboard" instead of TM Insider. 
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Microsoft Excel.  Pull clipboards also work great with Excel.  While you can use the option on a Quick 

Tab to "Send to Excel" such a process does not always achieve the desired result.  You may want to pre-

specify column heads, cell formats and column widths.  And you may also want to pull data from linked 

fields that would not show up on a list view. 

Multiple Records in Excel.  If you wish to pull multiple records into Excel, you need to setup your 

clipboard in a special way.  I recommend setting up a Tab-Delimited list.  Add your fields, but put a {TAB} 

code between each field and a carriage return at the end to delimit the end of each record. 

Microsoft Outlook.  There is a TM Insider button in Outlook that lets you pull clipboards into an e-mail.  

It works the same way as Word documents and can be quite effective for standardizing client 

communications.  

Push - Single Record 

If you "count the clicks" you will find that it takes more clicks to start in Word, add your clipboard and 

then use the TMSave process to profile your document into Time Matters.  For that reason, there is a 

PUSH method that lets you create the document profile and define the template and associated 

clipboard in fewer steps. 

• Start by selecting your data-source record, whether it be a contact, matter, task, event or UDR.  

You may use a trigger or an auto-entry to speed up the process. 

    

• Next click on TEMPLATE and then CREATE.  You will notice that with the autoentry, the Word 

Template and the Clipboard are already selected. 

 

Push - Single and Related Records 

The directions for a PUSH that includes related records are the same as above.  The difference is in the 

clipboard.  The SELECT option pulls up a Select Related Records wizard.  Here you can define the type of 

record, the type of relations (specified, automatic or both) and even apply a filter based on relationship 

code or classification code. 
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You can go one step further and allow the person using the 

clipboard to select by tagging the resulting related records for 

the one to be actually used.  

Once you finish the wizard, you still need to define which fields 

from the SELECT records are to appear in the clipboard. 

Push - Multiple Records 

Working with multiple records is ideal for mass mailings.  When 

the document template is combined with an electronic 

letterhead, where the letterhead properties are embedded in 

the document's header and footer, the software can produce 

hundreds of custom letters in seconds. 

The configuration of the clipboard is the same as above, with one exception.  You need to recognize that 

the clipboard will be repeated and thus need to add some sort of marker for the end of each clipboard.  

The {PAGE} code is an ideal marker, but you might 

choose something else. 

For multi-page letters, use letterhead with a 

different first page header/footer setting.  After you 

finish the assembly do a search/replace searching for 

the page breaks and replacing them with section 

breaks. 

Push Workflow 

The first example was a use of a push work-flow.  

After the tenth letter where you choose the 

template, choose the clipboard, choose the data-

source and name the file, you might think there is a 

better way.  If you have a lot of letters, take the time 

to learn how to create auto-entry document records 

and how to create action triggers to call those auto-

entry forms.  And, most important, don't forget to 

paste (Control-V). 

4  HotDocs®  

The integration to HotDocs comes in several flavors.  The integration is quite robust and allows for the 

transfer of potentially limitless amounts of data.  The sky is the limit.  As much information as you put 

into Time Matters, you can pull it all out, and massage the data into highly polished documents. 

Nevertheless, due to the way that HotDocs integrates with Time Matters, you will need to choose which 

method best suits your particular set of documents.  One key factor is whether the documents call for 

related records to a particular matter or core contact record.  The HotDocs Template Extension (to be 

explained below) requires you to map one Time Matters field to one HotDocs variable.  However, some 

HotDocs variables "repeat" in collections.  The one-to-one mapping therefore will not populate the 

repeating data.  One solution to this problem is a complex HotDocs script that maps multiple "linked 

contacts" into a single repeating contact record.  My preferred solution, at the present time, is the PUSH 
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and PULL method which uses Answer Source integration in a repeating HotDocs dialog to PULL in 

collection data. 

Pull - Answer Source Lookup 

The easiest integration to understand is the Answer Source integration. It functions just like a lookup in 

Time Matters.  You need to select the record type and Match the Fields.  If you cannot access Time 

Matters as an answer source, go into Time Matters and turn on integration: File -> Setup -> General -> 

User Setup -> Links -> HotDocs.  Be sure to test the link to ensure integration is setup on the workstation 

In HotDocs, first create a dialog and add the 

variables which you intend to map to Time 

Matters fields. Then, on the dialog, choose 

Options -> Answer Source -> Time Matters.  

Select type of record to pull data from.  Then 

match fields in Time Matters with equivalent 

HotDocs fields. Be sure that the field type in 

Time Matters matches the variable type in 

HotDocs.  Realize that field match is to the 

DEFAULT field name in Time Matters. 

Benefits of Answer Source Integration:  

Answer source integration includes a "write-

back" that lets you update the linked Time 

Matters record. Because the mapping is on a 

dialog, and HotDocs dialogs can repeat, you 

can bring in related parties as a TRUE 

Collection.  A Script Link button on the dialog 

can run data validation and interpretation 

scripts. 

Push – HotDocs Template Extensions 

The first integration that most administrators will use is a HotDocs Template Extension.  In Time Matters 

choose File -> Setup -> Templates -> HotDocs Template Extensions.  You have the ability to PUSH data 

from Time Matters into a HotDocs Answer File.  While limited to a SINGLE source record, with this tool 

you can gather data from records LINKED via lookup to the source record.  Theoretically, you can map 

up to 24,000 fields (155 * 155).  In practice, the maximum I ever used was a Core Matter record (all 

fields), a linked supplemental matter record, and 30 linked contact records (where I pulled in 35 fields 

each) for a total of 1360 fields mapped.  I then used a post import script to turn the 30 linked contact 

records into a single repeating contact dialog.  

Configuration Tips: Open the Setup wizard (File -> Setup -> 

Templates -> HotDocs Template Extensions).  Select your 

template from the LAST Opened HotDocs Library, and 

choose your assembly options. 

Field mapping is where all the work is.  To aid in this 

process, we apply strict field naming conventions for both 

the field names in Time Matters and for the variable names 

in Time Matters.  The field name in Time Matters should tell 

you the Area where the field is found, as well as its function.  
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The field name in HotDocs should closely match in some regards the Time Matters field name. 

Field Mapping Options: Component File matching is ideal if you have a shared component file for 

variables used by multiple documents.  You will need to upgrade to Time Matters Version 9, SR3B if you 

wish to use this feature. Custom Matching has the OPTION on a new template of copying the matching 

fields from a prior HotDocs template extension.  So my recommendation is to create a custom template 

that contains all the fields you intend to match and then copy that template as the basis for other 

individual documents.  In all cases, be sure to choose the appropriate form style so that you can identify 

all fields that have linked records. 

In doing the field mapping be sure not to neglect LINKED records. This is a major strength of HotDocs 

Template extensions.  Rather than having to bring all data onto a matter record, you can get contact-

specific data by using a mapping to a linked record. 

Push & Pull  

There are times where you wish to take advantage of a core matter record and several linked ancillary 

records to bring a mass of data into the HotDocs answer file.  But at the same time, you may also wish to 

bring information in from multiple contacts, such as all plaintiffs, defendants and creditors in a 

foreclosure litigation.  While you can use a script link in HotDocs to turn Name 1 TE, Name 2 TE etc. into 

a single repeat, you are better off using Answer Source Integration to pull in each individual contact 

record.  In such cases, you would use a Push from a HotDocs Template Extension to launch the assembly 

and use a pull from Time Matters Answer source Integration to get related contacts in a REPEAT.  This 

approach lacks the elegance of a PUSH, but does get you the maximum amount of data out of Time 

Matters.  It is, in fact, the method I prefer for most HotDocs/Time Matters integrations. 

Process, Validate and Clean 

Regardless of what you do, you will want to test and clean the data.  At the very least your HotDocs 

interview should ask the dialogs that contain fields that were mapped to Time Matters data so that you 

may review the data being imported.  More often, you may be best served to programmatically adjust 

some of the data from Time Matters: 

• Checkboxes can have a value of Y, N or unanswered.  You should have a script that takes the 

result and sets the value of a True/False variable. 

• Zip codes and other text beginning with a leading zero will often have the leading zero stripped 

out.  We write a script to restore the leading zero in the field in HotDocs. 

• Staff Codes may have related data, such as First Name, Telephone, and E-mail that you may wish 

to use in a document. 

• Date fields in Time Matters will not match with date variables in HotDocs unless the underlying 

DEFAULT form style uses a date field. 

Enterprise Only Options 

In a few rare circumstances, none of the options above will work.  This may occur where you are doing a 

mass-merge, but you need the functionality of HotDocs to apply rules and customization that cannot be 

accomplished with merge templates.   

In this case, you can get data directly out of Time Matters if you understand the structure of the SQL 

Server tables.  Using the database components in HotDocs, you can query the SQL Server using a matter 

or contact's SYSID.  These queries can be then matched in the database component to HotDocs fields.  

You will need to create data transformation routines for date and time fields, as well as some number 

fields and Boolean fields. 
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5  Merge Templates 

How they Work 

When you ask a software vendor whether their practice management software has "document 

assembly" and they say yes, most assuredly they are talking about merge templates.  This is the process 

of taking a Word or WordPerfect form and identifying places in the document where you can fill in the 

blanks based on data in your Time Matters database. 

As you can see above, Time Matters 

offers a lot more.  Nevertheless, in the 

word of the French lord in Monty Python 

& the Holy Grail, when asked whether he 

would join in the search for the "grail" he 

replied: "You silly English #$%#$#, I 

already got one!"  And so Time Matters 

has its merge templates. 

It is quite possible that Time Matters even takes its merge templates further than other products.  For 

rather than merely letting you merge data from the selected record, Time Matters lets you add a linked 

contact record (one linked off any field on the matter) or a linked matter record.  To this it includes the 

ability to do a pre-merge from a related task, event or contact.  And finally, it even includes access to 

fields on custom records.  

From this wealth of fields, Time Matters lets you 

select the actual fields to display and even the 

form style to use, then shows up on the pre-

merge list as fields that can be used in the form. 

Merge templates require extensive testing on all 

workstations to ensure they produce consistent 

results for all users.  If you are using Terminal 

Server or Citrix, there are other issues you need 

to consider in the placement of file locations. 

Benefits 

Before you get involved with a merge template, 

check whether the same result could be 

accomplished with a Formattable Clipboard.  

Realize that merge templates are ideal when you 

are working with a large number of source data 

records (i.e. multiple clients and/or matters).  

The merge template lets you work with highly formatted Word and WordPerfect documents in a way 

not possible with clipboards.  The merge eliminates some of the formatting headaches with clipboards.  

Moreover, if you already have a form bank, you can easily convert your existing forms to merge 

templates by referencing the files in the setup routine and then dropping in the appropriate fields. 
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Limitations 

A few words of caution:  you need to PLAN carefully which fields you are going to make available to the 

Merge Template and from which FORM STYLE.  If you change the form style, you may need to re-input 

the merge fields into the template.  Also, conditional language requires a good understanding of 

Microsoft Word or WordPerfect field syntax for conditional logic.  Unlike the clipboard, such logic can be 

nested, but it requires some fairly advanced Word training and is not for the faint of heart.   

For larger and more complex documents, the extra effort to get nested scripting and other rules into the 

document may not give you sufficient return on the time investment.  You may be better off using 

HotDocs which is designed to make the complex easy and the really complex feasible.  Moreover, with 

HotDocs, you can consolidate multiple versions into a single master template. 

6  About the Author 
This white paper was prepared by Seth G. Rowland, Esq. President, Basha Systems LLC 

www.bashasys.com sgr@bashasys.com (914) 827-9173.  Seth has been bringing the benefits of 

automation to lawyers since 1996.  For an 

understanding of best practices with legal 

document automation, read his blog, 

Document Assembly (and Case Management) 

found at www.bashasys.info. 
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